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PART I (GETTING STARTED) 

Introducing TriCaster™ Virtual Set Editor – installation and registration, a top-level overview of 

primary features, and a hands-on tour to get you started. 
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1 ABOUT THIS MANUAL 

 

 

Estimates are that between 60 and 97% of the human race hate 
reading manuals. Most prefer to jump right in, maybe asking a 
friend for occasional help … and who can blame them? 
 
This manual attempts to tell you what you need to know in a 
friendly, concise way, and also provides a comprehensive reference 
section you can turn to when you need finer detail. 

If you do hate reading, please take a moment to peruse at least this section, which explains the 

manual’s organization.  You may find you can escape with a minimum of reading. (Or, if you are a 

devout reader, you can be the hero others turn to for expert advice.) 

Part I – Getting Started: An introduction to TriCaster Virtual Set Editor – a brisk jog through 

fundamentals, including installation and registration, along with a feature walkthrough. If you’re 

a quick study, Getting Started may provide all you really need. 

 

Part II – Reference: This section covers the finer details of TriCaster Virtual Set Editor – for 

those who need it, and those who just like to know everything. 

 

Part III – Appendices:  Appendix B lists all shortcut keys.  Part III is also home to a question and 

answer section (“How Do I … ?”) and comprehensive keyword index. 
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2 INSTALLATION AND ACTIVATION 

 

 

This chapter explains how to properly install your new software for 
integration and use within TriCaster. 
  
It also reviews registration for warranty, updates and technical 
support, and product activation. After completing this short 
section, you’ll be all set to continue into the Walkthrough chapter 
that follows it. 

 

2.1 WELCOME 

NewTek TriCaster comes with network broadcast style virtual sets developed using proprietary 

NewTek LiveSet™ technology. TriCaster Virtual Set Editor (VSE) enables TriCaster TCXD850 and 

TriCaster TCXD300 users alike to customize their high definition (HD) live virtual sets. 

Decorate virtual sets with custom 

logos, modify color schemes, 

furniture options, create custom 

start and end points for zooms, 

adjust placement and scale for 

video inputs, and even create 

brand new sets from custom 

graphics files. 

TriCaster VSE is accessed from the 

TriCaster Startup control panel, 

and is really easy to use.  

Controls such as position, scale, rotation, color correction (brightness, hue, contrast and 

saturation), and the Media Browser will be immediately familiar to TriCaster users. 

Once a TriCaster virtual set has been customized, you can easily export it for immediate use in 

live production.  NewTek TriCaster Virtual Set Editor permits schools, broadcasters and 

independent producers to personalize their productions – easily and affordably.  

Figure 1 
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2.2 SYSTEM REQUIREMENTS 

 
TriCaster VSE can be installed on a NewTek TriCaster TCXD300 or TCXD850. (You should always 
check for TriCaster software updates prior to installing new Add-ons.) 

2.3 INSTALLATION 

To begin, let’s review ‘what came in the box’: 

 USB key 

 Installation instruction card (insert). 

2.3.1 GETTING READY 

1. Power up your TriCaster. 

2. Select the Shut Down icon on the icon ring in the TriCaster Startup Screen’s Home page.  

3. Click the Exit to Windows link at right. 

4. Click the Exit to Windows button in the confirmation dialog that opens next. 

(At this point, the TriCaster Startup Screen exits, and you are taken to the Microsoft 

Windows™ Desktop.) 

5. Insert the TriCaster VSE thumb drive into an unused USB port on TriCaster. 

2.3.2 INSTALLATION STEPS 

6. Click the Windows Start Menu icon at lower left on the Windows Desktop, and select 

the Computer button (to open a system file explorer). 

7. Double-click the icon for the TriCaster VSE USB thumb drive to open a file window. 

8. Run the installer application by double-clicking the TriCaster VSE Setup.exe icon. 

(On launch, the installer presents various dialogs to ask you to accept the end user license 

agreement, and other information as it proceeds.) 
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Figure 2 

9. Click Next in the introductory dialog to begin the installation process (Figure 2). 

10. Read the License Agreement in the following dialog, and then select I accept the 

agreement and click the Next button to continue. 

11. The following pane presents the TriCaster VSE readme, which contains version notes for 

your software.  (Some people memorize these to impress their family and friends, but 

this is not mandatory.)  Click Next when you are ready to continue. 

12. The installer will now set up TriCaster VSE on your system.  A progress gauge is shown 

during installation (Figure 3). 

 

Figure 3 



 

Page | 10 

 

 

Figure 4 

13. A final dialog announces successful completion of the installation process. 

2.3.3 TRICASTER VIRTUAL SET EDITOR LAUNCH 

14. After installation, the TriCaster Startup Screen will automatically appear. 

 

Figure 5 

15. The icon ring on the Home page now displays an Add-Ons icon – select this icon, and 

click the Virtual Set Editor link at right (Figure 5). 

2.3.4 REGISTRATION 

16. On first launch (and subsequent launches until registration and activation are complete) 

the registration dialog is shown (Figure 6). 
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Figure 6 

17. If TriCaster is connected to Internet, you can click the “Click here …” button to perform 

your TriCaster VSE registration online. 

18. Otherwise, note the Product ID shown in this panel, and visit the registration web page 

(as shown in Step 2) to register your software and receive your unlock code. 

19. Click Continue to display the TriCaster VSE desktop. 

Note: Virtual sets can be created before registering and activating VSE, but display a watermark.  

To remove it, simply re-open the project after activating the software, and then re-save. 
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3 VSE WALKTHROUGH 

 

 

This chapter provides a quick hands-on tour of the major 
components and functions of TriCaster Virtual Set Editor. In a very 
short time, its features and use will be second nature to you. 
 
More detailed reference material on all aspects of TriCaster VSE 
follows in Part II (Reference). 

Having installed TriCaster VSE in the previous chapter, we’re ready for a little cruise through its 

highlights. 

3.1 FIRST STEPS 

As Chapter 2 closed, TriCaster VSE was installed, registered, and activated.  (Even without those 

last two steps, you can continue to use TriCaster VSE throughout the 14 day registration grace 

period.  Note, though, that virtual sets created before activation display a watermark.  To remove 

it, simply re-open the project after activating the software, and then re-save). 

If you’re continuing from Chapter 2, you can skip ahead to the next heading, 3.2.  Otherwise, 

please follow these steps: 

1. If necessary, power up your TriCaster. 

2. When the Startup Screen appears, select Add-Ons on the icon ring. 

3. Click the Virtual Set Editor link at right to launch TriCaster VSE. 

3.2 THE STARTUP WIZARD 

The first thing you will see on launching TriCaster VSE is the Startup Wizard  (Figure 7).  This 

convenient panel makes it a breeze to create a new virtual set project, or pick up where you left 

off on a recent project. 

The Startup Wizard has two bins. The left-hand one is named Open Recent. Eventually, it will 

display icons for projects you have opened previously.  Initially though, it is empty – apart from 

Browse and Import Photoshop® folder icons (both discussed later). 
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The right-hand pane is labeled New Project from Preset, and shows thumbnail icons for all 

installed virtual set presets.  Each preset contains numerous modifiable and optional elements. 

 

Figure 7 

4. Click the icon for the City Loft virtual set preset. 

A progress gauge is shown as the various elements constituting the selected preset are loaded.  

In just a few moments, the default City Loft set is shown on the large Virtual Set Canvas that 

consumes the biggest part of the TriCaster VSE Desktop  (Figure 8). 

 

Figure 8 
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3.3 VSE DESKTOP TOUR 

5. Stop and take a look around the VSE Desktop.  The dominant feature is the Virtual Set 

Canvas, which is a large interactive preview pane – but take note, too, of the following 

additional details: 

 

 

Figure 9 

6. You will find the File, View and Help menus (Figure 9) at upper-left on the VSE Desktop, 

just beneath the titlebar. 

 

 

Figure 10 

7. The current TriCaster VSE project is identified at the opposite end of the titlebar, next to 

the [x] button (Exit).  Initially, this is simply the name of the preset you opened. 

 

8. Clicking Exit returns you to the Home page of TriCaster’s Startup Screen, after first 

prompting you to Save your project (when appropriate),. 

 

 

Figure 11 
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9. Figure 11 shows the Angles Bin, located at left in the VSE Desktop footer (beneath the large 

Virtual Set Canvas). These icons allow you to select which one of the angles included in the 

preset (such as Left, Center, Right, and so-on) to edit. 

 

 

10. The Animation Controls group is located 

at right in the Desktop footer (Figure 

12).  These controls allow you to set 

custom Start and End positions, as well 

as LiveSet zoom preset levels. 

 
11. The Control Stack  (Figure 13) occupies 

the entire right-hand side of the VSE 
Desktop. 
  
This pane shows a labeled header row 
for each and every editable item in the 
currently loaded project. 
 
Every header row, in turn, has a 
triangular gadget at left, which you can 
click to expand or collapse the controls 
for each item. 
 

12. Go ahead and click this triangle in the 
Monitor control header. Observe that 
the control group expands to reveal a 
bevy of adjustable settings. 
 

 
Figure 13 

 
13. Click the Monitor expand/contract triangle again to close the group. 

 

Figure 12 
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Figure 14 

 
14. In fact, let’s remove the virtual monitor from this scene entirely.  To do that, click the 

checkmark at right in the Monitor header to remove it (Figure 14).   
 

 

Figure 15 

The monitor vanishes from the scene (as shown by our somewhat anemic but nonetheless lovely 
and talented stand-in) – see Figure 15. 
 
Let’s make some additional modifications to the scene.  There are endless possibilities, but next 
let’s do something about the placeholder logo on the brick wall, behind our talent stand-in. 
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Figure 16 

15. Turn your attention back to the Control Stack, please, and expand the Wall Logo control 
group (Figure 17) by clicking the triangle gadget at left in its header. 

 

Figure 17 
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(Now, if your client is named “Your Logo Here Inc.”, you’re done.  Most, however, will prefer to 

supply a different logo.  For demonstration purposes, let’s replace the placeholder image with 

one of the default images that comes with TriCaster.) 

16. Click the drop-down menu labeled Source in the Wall Logo control group, and select 
Browse.  This opens the familiar TriCaster Media Browser (Figure 18). 

 

Figure 18 

17. Select the NewTek entry beneath the Stills header in the Locations column at left. 
 

18. In the File Pane at right, locate the icon named NewTek Logo.png in the Logos category, and 
click the OK Button. 
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Figure 19 

19. Drag the Scale numeric slider for X or Y to around 70% (Figure 19), and the result should look 
much like Figure 20. 

 

 
Figure 20 

 
Figure 21 

 
 

 

Figure 22 

20. Change the Style setting to Ignore Room Lights (Figure 22), and observe that shadows no 
longer appear on the logo - Figure 21. (You may well prefer the natural shadows, but we did 
want to show you what this control does.) 
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 Figure 23 

Let’s notice another useful TriCaster VSE attribute – item hinting. 

21. Roll your cursor over the Background header in the Control Stack.  The header ‘lights up’, as 
it were, even before you click it.  As you do so, take notice, too, that the item that is 
highlighted in the Control Stack is also highlighted in the Virtual Set Canvas (Figure 23).  
 

22. Item hinting makes it easy to see what each group in the Control Stack affects, making it a 
breeze to select the correct item for editing. 
 

23. Expand the Background group now, and (using the same technique as for the logo image), 
replace the default cityscape image with Jax Sunset.jpg file (located in NewTek>Stills). 

 

 
Figure 24 

 
Figure 25 

 



 

Page | 22 

 

24. That looks great, but we can do a little better yet.  Let’s adjust the background image 
placement slightly.  Set Position X to -13% and Position Y to -35% (see Figure 24). 
 

25. We’ll work with Input A (the talent input) next.  Expand the Input A header in the Control 
Stack, and use the Scale and Position settings to modify the scene roughly as shown in 
Figure 25. 
 

 

Figure 26 

Now that the Input A frame is smaller, we should take steps to ensure the maximum Zoom level 

is still what we want. 

26. Until now, we’ve been viewing the (default) Start position for this set.  Locate the Animation 
Controls group at right, beneath the main Control Stack, and click the thumbnail image 
beneath the End label. 

 
Notice that this permits us to see the animated effect performed on the Virtual Set Canvas. With 
the set now shown at its maximum zoom level, we can see that centering is a little bit off.  Let’s 
correct that. 
 
27. First, to help with placement, click the View menu at left above the Canvas, and turn on the 

16:9 Safe Area overlay (Figure 27). 
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Figure 27 

 
Figure 28 

 
This makes it easy to see that we need to change the ‘virtual camera position’, or – put another 
way – to ‘move the set’ (relative to the static camera position represented by the Input A frame).  
Unlike the real world, this requires no carpentry skills or heaving lifting. 
 
28. To ‘move the world’, simply drag the cursor over the Canvas with the left mouse button held 

down.  Using the Safe Area overlay as a reference to center things tastefully. 
 

29. You may feel that the actual zoom level needs to be tweaked, as well. There are several ways 
to do this – for now, simply drag up or down on the Canvas with the right mouse button 
depressed until you’re happy (Figure 28).  

 

 

Figure 29 

30. Finish up by clicking the Set button under the End thumbnail in the Animation Control group 
(Figure 29) to ‘lock in’ your changes. 
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31. Click the Start thumbnail to zoom out fully, and then click End to perform and animated 
zoom to see the result of all your modifications. 

 
We could continue endlessly, but let’s finish up at this juncture by saving our project, and 
exporting our modified set for direct use in TriCaster. 
 

 

Figure 30 

32. Click the File menu label above the Canvas, and select Save As (Figure 30). 
 

 

Figure 31 

33. Accept the suggested name or supply a new one (such as “City Loft Jax”, without the quotes) 
in the Save As dialog that appears, and click Ok.  A brief progress dialog will let you know 
when saving is complete. 
 

34. Now select Export to live … from the File menu (Figure 32).  The exported LiveSet will be 
listed in the LiveSet section of the Live Desktop’s Media Browser afterward. 
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Figure 32 

 

35. Click the Exit button in the upper right corner to close TriCaster Virtual Set Editor. 
 

36. Select Open (or New) on the icon ring in TriCaster Startup’s Home page.  Then click Live on 
the Session page to launch the Live Desktop. 

 

 

Figure 33 

All that remains is to test out your new custom virtual set.  You’ll find it listed in the Media 
Browser’s File Pane when you click the new User entry listed under the LiveSets header at left. 
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PART II (REFERENCE) 

A thorough examination of TriCaster Virtual Set Editor; every button, menu item, feature and 

control is considered in this section, so you can take full advantage of your software. 
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4 FEATURES AND CONTROLS 

 

 

TriCaster Virtual Set Editor is quite straightforward to use, and this 
is especially true if you are already familiar with common TriCaster 
controls and features. 
 
In this chapter, we’ll discuss each area of the application, explaining 
how the various controls operate and what effect they have, and 
revealing a few little tricks that you may find helpful along the way. 

 

4.1 STARTUP WIZARD 

 

Figure 34 

Whenever you launch TriCaster Virtual Set Editor, the Startup Wizard provides convenient and 

quick options.  The Open Recent pane at left displays icons for projects you have been working 

on lately.   

Initially, the bin is empty, apart from folder icons named Browse and Import Photoshop®. 
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Figure 35 

 The Browse option allows you to navigate to suitable content located elsewhere on your 

system. 

 The ability to Import layered Photoshop® files (.PSD) and convert them to LiveSets 

delivers amazing creative power.  Helpful details are provided in Section 4.7 of this 

manual. 

The New Project from Preset bin at right shows all of the installed VSE Presets, and allows you to 

open a new project based on your selection with a single click. 

 

Figure 36 

Let’s take a closer look at the various components of TriCaster Virtual Set Editor’s Desktop. 
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4.2 MENUS 

4.2.1 FILE 

 

Figure 37 

The File menu, important as its functions are, hides no mysterious secrets.  Let’s review each 

entry it offers in turn. 

 

Figure 38 

 The Open menu point presents TriCaster VSE’s Recent and Preset panel again, to allow 

you to open a new project from a preset or one of your previously modified projects. 
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 Selecting Recent from the File menu shows a list of the five latest projects that you have 

worked on, making it easy to jump to one of them in its last-saved state. 

 

 Save and Save As are similar and familiar – use the latter to save the currently open 

project, or the latter to save it under a new name. 

 

 Selecting Export to live … compiles the shots (angles) of the current TriCaster VSE 

project, and sends them to the proper location for use in the Live Desktop. 

 

 Finally, Exit closes TriCaster VSE, returning you to the Startup Screen. 

4.2.2 VIEW 

 

Figure 39 

The View menu selections toggle different Virtual Set Canvas guides on and off, as described 

below. 

 The 16:9 and 4:3 Safe Area guides make it easy to see what parts of the overall canvas 

will appear in the frame on corresponding HD and SD devices.  The inner rectangle 

represents a Safe Text guide, while the outer one marks a Safe Action area. 

 

 The Center Cross divides the screen into quadrants, and makes it easy to ensure you 

have things properly aligned on the X and Y axes. 
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4.2.3 HELP 

 

Figure 40 

 The View Help item in this menu opens this manual for convenient review. 

 Select About Virtual Set Editor to peruse various details and lore related to TriCaster 

VSE, including credits. 

 

 Finally, use the Check for Updates item (when connected to the Internet) to ensure you 

are running the latest release of the software. 

4.3 ANGLE BIN 

 

 

Figure 41 

 

Figure 42 

Many presets offer more than one camera angle on a virtual set, and you can modify any or all of 

them at will.  To switch to a different angle, simply highlight its icon in the Angles Bin by clicking 

it.  The corresponding view will appear on the Canvas, ready for you to edit its attributes. 

To rename an angle, right-click its icon in the bin, and select Rename (Figure 42). 
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4.4 CONTROL STACK 

The Control Stack contains nested controls for different set elements that can be modified, or 

even disabled.  Even so, it’s quite easy to use, as similar attributes present similar controls in the 

various sets.  We’ll consider the way these work, and leave the creativity to you.  

Let’s take a closer, using a typical example – the Monitor group from the City Loft set preset. 

4.4.1 ITEM HEADERS 

 

Figure 43 

Initially, all we see of the Monitor control group is its collapsed header (Figure 43).  As you know, 

you can expand this by clicking the triangle gadget at left, which twirls downward and reveals the 

nested controls when you do so (Figure 44). 

 

Figure 44 
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You may find it even faster to simply double-click the group header.  Like the triangle gadget, this 

expands or contracts the group.  

 

Figure 45 

Additionally, take note of the bright checkmark at the extreme right end of the group header. As 

we saw back in the Walkthrough Chapter, clicking the checkmark toggles it on or off, indicating 

that the feature the group controls is either enabled or disabled. 

Hint: You’ll recall that group headers highlight as you roll the cursor over them, and that the 

corresponding feature will also highlight on the Canvas as you do so.  Some local items nested 

within a control group also provide this handy behavior. 

4.4.2 SOURCE MENU 

When the group is expanded, we see that its first option is labeled Source.  Clicking the currently 

assigned source (in this case, Input B), reveals a drop-down menu that allows you to specify a 

different source to display on the monitor.   

Typically, monitors in virtual sets really are used to display Input, but in some cases you might 

substitute a fixed corporate logo or station ID graphic.  In any case, you’ll see Source menus like 

this one in other places, so let’s see what it offers (Figure 46). 

 

Figure 46 
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Selecting Browse opens TriCaster’s custom Media Browser, which allows you to select an image 

from any existing TriCaster session, including ‘grabs’ from live video, imported images and 

graphics, user-added Locations, and so on. 

The Recent menu point allows you to quickly re-locate an image file from among those you have 

selected recently. 

4.4.3 POSITION, SCALE, AND ROTATION 

 

Figure 47 

Next we see controls in rows labeled Position, Scale, and Rotation, respectively.  

 Click and drag on the Position button (identified by a double-headed arrow) to relocate 

the assigned vertically or horizontally within its frame on the Canvas.  

 By dragging left or right on the X and Y numeric sliders at right, you can adjust the 

position on a single axis at a time. 

 Alternatively, you can constrain the action to one axis when dragging on the double-

headed arrow button by holding down the Ctrl key before dragging. 

Hint: If you click a numeric field (or right-click it), you can type a value into the field using the 

keyboard – press Enter to complete the editing action, or Esc to cancel it). 

Dragging the cursor on the Scale button (magnifying glass) affects the scale of the overlay.  

 When the nearby lock button is enabled, dragging in any direction affects size equally on 

both axes. 

 Otherwise, dragging vertically changes the height of the overlay, and dragging 

horizontally affects its width. 

 Again, drag just one of the numeric gadgets next to the Scale button (with lock disabled) 

or hold down Ctrl when dragging over Scale to independently modify just one dimension 

of the item (width or height). 



 

Page | 37 

 

In similar fashion, drag the pointer over the Rotation button with the left mouse button pressed 

to turn the overlay source in 3D space, as follows: 

 Drag left/right to rotate the source about the Y (vertical) axis. 

 Drag up/down to rotate the source about the X (horizontal) axis. 

 Drag up/down while holding down the right mouse button to rotate about the Z axis. 

 Drag on a single numeric slider at right, or hold down Ctrl while dragging to constrain 

rotation to one axis. 

Position, Rotation and Scale can be reset by clicking Reset Positioning. 

Hint: Reset most controls to their default value by holding down Shift while double-clicking it. 

4.4.4 PROC AMP & OPACITY 

 

Figure 48 

The Opacity slider defaults to 100%, or fully opaque.  Reducing the value makes the object 

increasingly transparent. 

Brightness, Hue, Contrast and Saturation controls are familiar from TriCaster’s Live Desktop, 

where they are located in the Proc Amp controls for inputs and output. 

 Brightness: Adjustment range from -100 to +100 IRE (the default being 0). As reference, 

the full luminance range of the visible portion of a video signal can be thought of as ‘100 

IRE units’ (named for the Institute of Radio Engineers) – ignoring minor regional 

variations. 

 

 Contrast – Adjustment range from 0 - 500% (default 100%). 
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 Hue – Adjustment range from -180° to +180°.  Adjusts the master color of the selected 

Source, swinging the entire image through the color wheel’s spectrum. 

 

 Saturation – Adjustment range from 0-500%.  Zero saturation results in a ‘black and 

white’ picture; increased saturation results in richer colors. 

High saturation values can exaggerate the color portion of the signal.  Note that over-

saturated colors are considered illegal for broadcast transmission, and may result in 

display problems on some devices.  

(The result of clicking Reset Color will come as no great surprise, so perhaps we’ll leave that as a 

student exercise.) 

4.4.5 STYLE 

 

Figure 49 

A Style menu doesn’t appear in the Monitors group, but we should give it a moment’s attention 

as well.  Expand the Input A control group to show it. 

Style is a bit of a joker, since it may govern different features in various places.  One very useful 

thing it offers in some instances is that it permits you to select between one-person or two-

person placeholder images on the Canvas for Input A. 

Elsewhere, it may be used to provide many diverse options, such as enabling or disabling lighting 

effect.  Be sure to check it out wherever it appears. 



 

Page | 39 

 

4.5 ANIMATION CONTROLS 

We reviewed the use of the Animation Controls (Figure 50) in the Walkthrough Chapter.  The 

thumbnail icons show the currently established Start and End zoom preset positions.  

 When the current view is exactly at either the Start or End position, the corresponding 

thumbnail is bordered in gold. 

 

Figure 50 

 Clicking either thumbnail begins an animated zoom preview right on the canvas.   

 Double-click a thumbnail to bypass the animated zoom, cutting directly to the position 

represented by the thumbnail. 

 Alternatively, drag the zoom slider beneath the thumbnails to manually move through 

all intermediate zoom levels.  

Clicking the Set button beneath a thumbnail updates the Start or End preset to match the 

‘camera position’ and ‘zoom level’ currently displayed on the Virtual Set Canvas. 

 

4.6 VIRTUAL SET CANVAS 

The large Virtual Set Canvas dominates the screen.  It not only provides feedback on your work 

in progress, but also supports certain editing operations, and even allows you to preview 

animated zooms.  In addition, as previously mentioned, various objects on the Canvas may be 

highlighted when you roll the mouse cursor over their respective headers in the Control Stack. 
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Figure 51 

The Canvas allows you to interactively adjust the zoom level and center frame point for the Start 

and End positions.  

When zoomed out to the maximum level for the set, dragging the cursor on the screen has no 

effect.  But as soon as you have zoomed in a bit, you can drag left, right, up or down to re-center 

the frame, in essence relocating its zoom target. 

Hint: Zoom and center adjustments are not stored as the Start or End preset positions until you 

press their Set button in the Animation Controls.  For example, if you click End, adjust the center 

position, then – without having clicked Set – click End again, the original End position is restored. 

There are several ways to zoom in and out on the Canvas:  

 Hold down the right mouse button, and drag up or down. 

 If you mouse has a scroll-wheel, rotate it to zoom in and out. 

 Press Ctrl with the + or – keys (top row plus and minus sign). 

 Hold down the Alt key, and drag up or down. 



 

Page | 41 

 

4.7 IMPORTING PHOTOSHOP® FILES 

 

Figure 52 

As mentioned earlier, TriCaster Virtual Set Editor can also import PSD files, and create LiveSets 

from them.  This is extremely useful, since it permits users to prepare layered files for conversion 

to LiveSets using familiar 2D art software. 

 
Figure 53 

 

 
Figure 54 

 

Note that the order of layers in the Control Stack for PSD files you import is inverted compared 

to the original – so, for example, the Background layer is at the bottom of the Layer Panel in 

Figure 53, but appears at the top after import (Figure 54). 
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4.7.1 FILE REQUIREMENTS 

There are a few things to know about working with PSD files in TriCaster VSE.  Notably, all layers 

in the file should be rasterized (i.e., bitmap layers, not dependent on masks, vector graphics, 

transfer modes, etc).  Also, images should be RGB Color Mode (not CMYK, etc). 

4.7.2 INPUT LAYERS 

For TriCaster VSE purposes, image layers in the file serve one of two purposes.  

Either a layer contains graphic imagery that will for part of the composite 

result, or it is an “Input Layer”.  

Input layers are replaced by the video sources assigned in TriCaster’s Virtual 

Input tab in the finished LiveSet.  TriCaster VSE identifies “Input layers” in 

imported PSD files by their layer name. You can use the name to identify the 

layer as a proxy for either Input A or Input B. 

A layer with any of the following names will be replaced by Input A: "Input A", 

"InputA", or their lower case equivalents.  When the PSD file is imported, input 

layers are listed in TriCaster VSE’s Control Stack as “Input Layer 0”, “Input Layer 1”, and so on.  

It’s also possible to assign a custom name to a video input layer when creating VSE projects from 

Photoshop® files.  Simply assign the layer a name as shown on the lines below: 

Input A name = “Stand-up Talent” 

or, as another example:  Input B name = “PiP” 

LAYER GROUPS 

On conversion, Photoshop® image layers that are nested inside groups will be organized into 

similar groups under headers in TriCaster VSE’s Control Stack.  This is a useful way to make it 

easier to manipulate VSE layers. 

Figure 55 
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DISTORTION AND WARPING 

 

Figure 56 

If you have a recent version of Photoshop® that supports input and output of high dynamic 

range imagery, more elaborate transformations or distortions are possible (Figure 56).   

You will find a file named “VSE UV Gradient.exr supplied in your TriCaster VSE installation folder 

(specifically, in the folder C:\TriCaster\AddOns\Virtual Set Editor\Extras). 

This special image is a UV gradient in the form of an OpenEXR file.  It is intended to serve as a 

proxy video input layer proxy in your Photoshop®project when you need more powerful input 

layer transformations. The Photoshop project must be 16bit color depth (or 32bit) when you load 

the .exr file (save the final layered PSD in the same color depth to preserve your transformations 

and distortions accurately).   

Remember to use the (.exr) proxy gradient for all video input layers in the project in this case, 

with one exception: completely empty (transparent) layers will be treated as a full-frame video 

input layer. 

Hint:  When you do not require advanced transformations, simply use standard 8bit color depth 

for both project and file exports. Only the opacity in input layers is recognized by TriCaster VSE in 

this case; any color information is ignored. 
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INPUT LAYERS, PROXIES, AND OPACITY  

In the assumption that Input A is most often used for greenscreen shots, imported Input A layers 

display the ‘phantom’ One Person proxy on the Canvas by default  (and in the icon for the 

resulting LiveSet).  You can select a different proxy image for the layer from the Style menu if 

you wish. 

Note that if an input layer is completely empty, TriCaster VSE infers a full screen input.  On the 

other hand, if the layer contains a smaller opaque shape on a transparent field, TriCaster VSE 

attempts to position the live video accordingly in the result.  

If a solid color input layer is neither completely empty nor fully opaque, transparency is applied 

to the video source as appropriate.  If the filled shape does not truly correspond to the 

rectangular aspect of your video sources, you may find it useful to use TriCaster VSE’s Position 

(and Scale) tools to tweak the video source within the shape. 

Hint: While this means you need to avoid inadvertently leaving just a few stray pixels in a layer, it 

also means that you are perfectly free to design Picture in Picture effects from all manner of 

different shapes – circles or ellipses, squares, soft-edged vignettes, and so on. 

An additional consideration: input layer conversions work on the basis of opacity in the layer at 

this time. Distortions (such as warping, rotation, smearing, etc.) in the image layer are not 

recognized by TriCaster VSE. 

Caution: Care must be taken if either video input (A or B) is referenced more than once in the 

layers of the file. Distortion will occur in the result if ‘same sources’ overlap.  This is inevitable, 

unless the foremost ‘same source’ layer (from the viewers perspective) is fully opaque – i.e., has 

no transparency at all – where the overlap occurs. 

KEYING 

It is not really necessary to pre-determine whether or not chromakeying  will be applied to Input 

A in the result.  If LiveMatte is applied to the video source for Input A when the LiveSet is 

displayed in TriCaster’s Live Desktop, the background behind it in the LiveSet will be seen (Figure 

58).   
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Figure 57 

 
Figure 58 

With LiveMatte disabled, the video source will obscure the background, just as you would 

expect.   

Note: Input B does not support keying effects at this time. 

PERSPECTIVE EFFECTS 

It might be that you wish to apply a perspective effect to a video input.  You will find it works 

best to simply supply a full-screen layer in this case, and do the positioning using TriCaster VSE’s 

Control Stack. 

 

Figure 59 

However, if you want a shadow (as in Figure 59), frame, or similar graphic element to be rotated 

or skewed to match a rotated input layer, this must be done in the source file before import.  

(Afterward, use the Position controls to adjust the input layer to match.) 
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PART III (APPENDICES) 

A time-saving question and answer section, followed by an extensive listing of Shortcut Keys, 

schematic diagram and keyword index … 
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A HOW DO I … ?   

 

 

In this section, we’ll consider the most common questions TriCaster 
Virtual Set Editor users may have (and of course we’ll provide the 
answer, too). 
 
The answers are intentionally brief – perhaps just a reminder of 
one or two steps required to perform some operation. For this 
reason, we’ll also point you to explanatory information elsewhere 
in this manual whenever that would be useful. 
 

 

If you’ve largely mastered your TriCaster VSE but have a specific question, this may be the best 

place to look first.  The headings that follow list related questions and answers together, along 

with cross-references and other helpful remarks. 

Hint: The NewTek website includes a comprehensive FAQ database containing a wealth of useful 

information on all of its products – please see http://www.newtek.com/faq/  

How do I ... 

Virtual Sets ..............................................................................................................................50 

Add more virtual set presets? ..............................................................................................50 

Add a background to my second double-box? .....................................................................50 

Create a a completely custom virtual set? ...........................................................................50 

File Management.....................................................................................................................51 

Locate my new virtual sets in TriCaster’s Live Desktop? .......................................................51 

Organize virtual sets in custom locations? ...........................................................................51 

Delete unwanted virtual sets? .............................................................................................52 
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A.1 VIRTUAL SETS 

A.1.1 ADD MORE VIRTUAL SET PRESETS?  

NewTek will offer optional content packs with more virtual set presets from time to time.  The 

new presets will be installed to the correct location on your TriCaster automatically. 

A.1.2 ADD A BACKGROUND TO MY SECOND DOUBLE-BOX?  

Chromakeying (LiveMatte) is supported for Input A in TCXD850’s Virtual Inputs, but not for Input 

B.  You can assign Input A to either Box 1 or Box 2 (or, though seldom used, both of these) when 

creating a double-box virtual set in TriCaster VSE.  

Then, when you apply LiveMatte to source selected as Input A in the Virtual Input tab (Live 

Desktop), the background you chose for the box in TriCaster VSE appears behind it wherever the 

chromakey settings result in transparency. 

A.1.3 CREATE A COMPLETELY CUSTOM VIRTUAL SET? 

The primary raison d’être for TriCaster VSE is to allow TriCaster TCXD300 and TCXD850 users to 

easily customize LiveSets to their local need.   In addition, it allows users to create completely 

custom virtual sets by importing layered Adobe® Photoshop® PSD files (see Section 4.7). 

Beyond this, it is not anticipated that most users will wish to pursue custom LiveSet authoring.  In 

some cases, user may utilize specialist services offered by various third-party developers rather 

than endeavoring to master the skills (and tools) required.  For those who do wish to engage in 

advanced set authoring, more powerful tools are available in the form of the TriCaster TCXD 

LiveSet SDK, a command-line tool provided for serious LiveSet developers. 

The TCXD LiveSet SDK allows advanced users to create virtual sets from content authored in a 

wide variety of content creation applications (typically 3D, paint or compositing programs).  It 

consists of a complete set of developer tools that can be integrated into a production pipe-line 

for compiling and debugging virtual sets for use with TriCaster TCXD systems.  The prerequisites 

for TriCaster TCXD LiveSet SDK users follow:  

1. Agreement to and compliance with end-user license and non disclosure agreement. 
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2. A 64bit computer system and operating system (such as Windows Vista™ 64bit or 

Windows 7™ 64 bit). 

3. A TriCaster TCXD300 or TCXD850 (to test your LiveSets). 

4. An application capable of creating high dynamic range imagery (full precision floating 

point formats, such as .EXR.) and working knowledge of same. 

5. Experience in the creation of LiveSets and knowledge of their use. 

6. Users should be comfortable working with command line applications, .bat and .xml 

files. 

Developers may apply for participation in the TriCaster TCXD LiveSet SDK program by sending 

email to liveset@newtek.com. 

A.2 FILE MANAGEMENT 

A.2.1 LOCATE MY NEW VIRTUAL SETS IN TRICASTER’S LIVE DESKTOP?  

7. When you perform a Save As operation, the modified virtual set is stored in the User 

folder of the default LiveSet effects location. 

8. Open a TriCaster session, and click a Virtual Input tab. 

9. Click the Add button in the Virtual Input tab, to show the Media Browser. 

10. You will see a User sub-heading listed (along with NewTek) under the LiveSets header in 

the Location List at left in the Media Browser. 

11. Click the User location entry and icons for your new LiveSet angles will be shown in the 

File Pane at right. 

A.2.2 ORGANIZE VIRTUAL SETS IN CUSTOM LOCATIONS?  

1. To move your virtual sets to custom locations, select the Shutdown icon on the Home 

Page of TriCaster’s Startup Screen, select Exit to Windows, and confirm this decision. 

2. Navigate from the Windows Desktop to C:\TriCaster\Effect\LiveSets. 

3. Create a new sub-folder with the custom name you wish to appear alongside NewTek 

and User in the Media Browser Location List (under the LiveSets header). 

4. Drag the folder(s) for the LiveSet you wish to appear in the custom location into the new 

folder you created earlier. 
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5. Then simply re-launch TriCaster, and re-open your session.  The newly created folder 

will appear as a sub-heading in the Media Browser’s Locations List, and its content will 

be displayed in the File Pane at right when you select it. 

A.2.3 DELETE UNWANTED VIRTUAL SETS?  

1. You may create some virtual sets that, for one reason or another, are not ‘keepers’.  To 

remove them from TriCaster entirely, select the Shutdown icon on the Home Page of 

TriCaster’s Startup Screen, select Exit to Windows, and confirm this decision. 

2. Navigate from the Windows Desktop to C:\TriCaster\Effect\LiveSets. 

3. Locate the folder for the LiveSet you wish to delete, then simply right-click on it and 

select Delete from the context menu. 

4. Re-launch TriCaster. 
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B KEYSTROKE SHORTCUTS 

 

B.1 MENU OPERATIONS 

 

New Ctrl + n 

Open Ctrl + o 

Save Ctrl + s 

Save As  Ctrl + S (Shift + s) 

Close Alt + F4 

Help F1 

 

B.2 VIRTUAL SET CANVAS 

 

Zoom In  Ctrl + (plus sign) 

Zoom Out Ctrl - (minus sign) 

Drag to zoom Alt + drag mouse up/down 

Constrain dragging (panning) Hold Shift before dragging 

 

B.3 CONTROL STACK 

 

Reset control to default value Shift + double-click 

Constrain drag operation (pan/scale direction, rotation axis) Hold Ctrl before dragging 

 

B.4 ANIMATION CONTROL  

 

Jump to current Start preset position Home 

Jump to current End preset position End 





 

 

C VERSION NOTES 

This section lists changes and features that are new in this version: 

 Improved video source mapping from imported imagery (Section 4.7.2). 

o 16 or 32 bit PSD file layers support rotation and distortion of video inputs in 

virtual sets. 

 

 PSD (Photoshop® Document) layer group support (Section 4.7.2). 

o Improved organization and control in custom VSE projects created from PSD 

files. 

o Grouped layers convert to expandable VSE groups on import. 

o Layer group names convert to VSE stack group header names. 

 

 Rename individual virtual set angles in VSE (Section 4.3). 

 





 

 

D INDEX 

 

A 

Add-Ons, 11, 13 

Adobe® Photoshop® Files, 41, 50 

Angle Bin, 33 

Angle, rename, 33 

Angles Bin, 16 

Animation Control, 23 

Animation Controls, 16, 22, 39 

B 

Browse, 19, 36 

C 

Canvas, 21, 39 

Check for Updates, 33 

Chromakeying, 44, 50 

Control Stack, 16, 18, 34, 41 

Headers, 34 

Hinting, 21 

Source, 35 

D 

Distortion, 43 

I 

Import Files, 41, 50 

Input Layer, 42 

Installation, 8 

K 

Keying, 44, 50 

L 

Layer Group, 42 

Layer, Video Input, 42 

LiveMatte, 44, 50 

M 

Media Browser, 19, 25, 36 

Menus, 15 

File, 31 

Open, 25, 31 

Recent, 32 

Save As, 24 

Help, 33 

Check for Updates, 33 

View, 22, 32 

P 

Photoshop® Files, 41, 50 

Position, 36 

Preset, 14, 30 

Proc Amp, 37 

PSD Files, 41, 50 

R 

Registration, 11 

Rename Angle, 33 

Rotation, 36, 45 

S 

Safe Area, 22, 32 

Scale, 36 

Startup Wizard, 13, 29 



 

Page | 58 

 

Style, 38 

U 

Updates, 33 
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Version Notes, 55 
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Virtual Set Canvas, 21, 39 
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Z 
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